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CHAPTER 3: CUSTOMIZING WINDOW LAYOUTS 
Training Objectives 

Actively participating during this chapter helps you learn how to: 
 

• Modify window displays. 
• Modify fields in the layout window. 
• Add fields to a window. 
• Add fields to a scrolling window. 
• Set the tab sequence in a window. 
• Add graphics to a window. 



Microsoft Official Training Materials for Microsoft Dynamics ™ 
Your use of this content is subject to your current services agreement 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Modifier with VBA in Microsoft Dynamics GP 9.0 

Page 46 

Changing Individual Window Displays 
Microsoft Dynamics™ GP uses text prompts as identifiers for objects that exist 
on a window such as fields, list boxes, option buttons, and check boxes. Using 
the Modifier Layout window, you can change the existing text that appear in 
Microsoft Dynamics GP. Text prompts can be changed for a single window so 
the wording is more reflective of your business's activities. You can also have 
text prompts stand out by changing fonts, color, and formats.  
 

 
 
HINT: To rename a prompt throughout the entire application, use the Strings option 
on the Resources menu. For more information on this menu option, refer to the 
"Changing Global Resources" section found later in this training manual. 

 

Modifying the Text Prompt 
To modify the text prompt from within Modifier: 
 

1. Open the form and window that contains the text prompt you want to 
change.  

2. With the window layout open, click the static text tool in the Toolbar 
window.  

3. Click the prompt you want to modify.  

 

 
 

4. Use the arrow keys to position the cursor within the prompt, and edit 
the existing text using your keyboard.  

5. After changes are complete, click another text prompt to modify or 
select the arrow tool to make other selections within the layout.  
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Setting Visual Properties for the Text Prompt 
You can set visual properties for any object in the window layout, including text 
items such as prompts. Visual properties allow you to change the color, font, and 
format of a text item to make more important information stand out. If the 
Properties window is not displayed, select the Layout menu then Properties. Next 
select the prompt with the arrow tool, and then move the pointer to the Properties 
window.  
 
HINT: Set the same drawing options for more than one prompt at a time by pressing 
the shift key and selecting all of the fields to change. Then when using the Properties 
window, the properties are set for all of the selected items. 

 
For example, you want to display the text prompt of a field in red to distinguish 
this information from other information in the window.  
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The following table lists the visual properties available for text prompts. 
Asterisks (*) indicate the properties that can be changed using Modifier. 
 
Visual Property Description 
Alignment* For text objects, indicates whether the text is left, center, or 

right-aligned.  
Appearance* Changes the way the object draws on the window. Select 

from: 2D Border, 3D Border, or 3D Highlight. 
BackColor* Specifies the background color of the object.  
Border* For text objects, specifies whether a border is drawn 

around the object. 
Font* Specifies the type style and size to use for text objects. 
FontBold* If set to true, displays text objects in bold type. 
FontColor* For text objects, specifies the color of the text. 
FontItalic* If set to true, displays text objects in italic type. 
FontUnderline* If set to true, underlines text objects. 
Pattern* Specifies the pattern to apply to the background. 
PatternColor* Specifies the color of the pattern applied to the 

background. 
Position − Left* Indicates the position of the left edge of the object, 

measured in pixels from the left edge of the window. 
Position − Top* Indicates the position of the top edge of the object, 

measured in pixels from the top of the window. 
Resize − 
Horizontal* 

Indicates how a field should grow or shrink horizontally 
when resized. 

Resize − Vertical* Indicates how a field should grow or shrink vertically 
when resized. 

Size − Height* Indicates the object height, measured in pixels. 

Size − Width* Indicates the object width, measured in pixels. 
Visible* Specifies whether the text prompt should be visible. 
Zoom* Specifies whether a visual indicator appears for the field. 

The visual cue indicates that you can click the text prompt 
to zoom to more information for the corresponding field. If 
set to true, the text appears with an underline and a custom 
font color. 
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Repositioning and Resizing the Text Prompt 
Changes made to the prompt name or the style of text can move the prompt 
slightly out of alignment or require you to adjust the size of the object. To 
reposition the prompt, use the arrow tool to select the object. After the prompt is 
selected, "handles" appear on the text object. These indicate which prompt is 
selected and can be used to drag the prompt to a different location on the 
window.  
 

 
 
To resize the prompt, use the arrow tool to select the object. Once selected, 
"handles" again appear on the text object. These allow you to resize the prompt. 
Click and drag on the appropriate handle to specify a new size for the text 
prompt.  
 
HINT: After the text prompt has been selected, use the arrow keys on your keyboard to 
move the prompt one pixel at a time to the left, right, up or down. In addition, the 
Properties window can be used to specify the pixel position and pixel size of each text 
object. 

 

Previewing and Saving the Modifications 
With a window layout open, preview the changes made to the window by 
selecting LAYOUT→PREVIEW. The form is not functional but it displays your 
modifications. 
 
Continue making changes to this window using other procedures in this manual, 
or save the changes by closing the layout. There is no menu option to save 
changes. When closing the layout, an alert message appears asking you to Save, 
Discard, or Cancel the changes. If satisfied with the changes to this window, 
click the Save button.  
 
To view all of the changes made with Modifier, return to Microsoft Dynamics 
GP and grant access to the modified windows using either the User Class Setup 
or Security Setup window.  
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Modifying Fields in a Microsoft Dynamics GP Window 
Fields are used on windows to display specific information from the tables in the 
application. Using Modifier, you can manipulate how the data appears in a 
Microsoft Dynamics GP window by changing the way the information currently 
displays or by adding new information. Modify fields the following ways: 
 

• Rearrange the fields on a window 
• Hide fields not being used 
• Add fields  

 

Modifying Field Displays 
As with text prompts and other objects on a Microsoft Dynamics GP window, 
you can modify fields and the information that displays in those fields. Using the 
Layout window, change font types, sizes, and colors to make the window look 
more like your paper forms or to draw more attention to important information. 
Also rearrange fields in the window so they appear in the order in which you 
prefer to use them.  

Selecting a Field on the Window Layout 
Open the form and window that contains the field you want to modify. When the 
window layout appears, use the arrow tool from the Toolbox to select a field on 
the window. Selecting the field with the arrow tool places "handles" on an object. 
 

 
 

Setting the Properties for a Field 
With a field object highlighted or selected in the layout window, you can set a 
variety of options for that field using the Properties window. These options 
determine how the field is displayed and how data can be entered into the field. 
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HINT: Set the same field properties for multiple fields at one time by pressing the Shift 
key and selecting all of the fields to change. 

 
The following tables list the object and visual properties that are available for a 
field. Asterisks (*) indicate the properties that can be changed using the Modifier. 
 
Object Properties Description 
AutoComplete For string fields, specifies whether the field will use the 

auto-complete capability. If this property is set to true, the 
contents of the field will automatically be completed as 
the user types, based on a list of values associated with 
the field. 

AutoCopy Specifies whether information can be automatically 
transferred between the field in the window and its 
corresponding table field. If set to false, the field is 
unaffected by processing that copies information to or 
from the field.  

Cancel If set to true, the process associated with this field runs 
when the user presses Esc on their keyboard. This is 
typically set to true for a Cancel push button field and is 
available only for push button fields. 

DataType* Indicates the data type used for the field. 
Default If set to true, the process associated with this field runs 

when the user presses Enter or Return on their keyboard. 
This is typically set to true for OK or Save push button 
fields and is available only for push button fields. 

DefaultDblClick 
 

Setting this property to true allows the user to double-
click a list box field to accomplish the action of selecting 
an item and clicking the push button whose Default 
property is set to true. 

DisableLookup* If set to true, this property disables corresponding lookup 
push buttons as soon as the given field is disabled. 

DraggableCols 
 

Applies only when the list view is displayed in report 
view mode. True indicates the user can reorder columns 
by dragging them. False indicates columns cannot be 
reordered by the user. 

Editable* Specifies whether the user can edit the contents of the 
field. 

EditMode* For text fields, this property specifies how text fields can 
be edited. If set to DisplayOnly, the text field cannot be 
edited. If set to Editable, the text field can be edited. If set 
to SelectOnly, the text can be selected, but not changed. 

EndTransaction When set to true, this means that all processing for a 
transaction is completed when the push button is selected. 
This property is available only for push button fields. 
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Object Properties Description 
Field Indicates the name of the field used and allows you to 

view characteristics of the field definition. 
FieldID Indicates the resource ID of the field. 
FieldType Indicates whether the field is a global field or a local field.
HelpContextID Lists the help context ID value for the field. 
Hyperspace If set to true, the processing scripts run for the field as 

soon as it is selected, but focus does not move to the field. 
It remains in the field that previously had focus. This 
property is available only for button fields. 

LinkedFormat Lists the format field linked to the current field.  
LinkedLookup Lists the lookup field (typically a button field) linked to 

the current field.  
LinkedPrompt Lists the prompt linked to the field.  
MultiSel 
 

True indicates multiple items can be selected in the list 
view. False indicates only one item can be selected. 

Password* If set to true for string fields, the field displays X's instead 
of the data entered in the field. This is typically used for 
password fields. Click this option if you want to display 
the field, yet not the information in the field. 

Required* Specifies whether the field is required for a transaction or 
record to be saved correctly. Set this property to true to be 
sure the user enters a value in this field. Also, if set to 
true, and the Show Required Fields menu item is selected, 
any prompt linked to the field is displayed according to 
the color and style specified in the User Preferences 
window. 

SaveOnRestart* If set to true, when the form or window is restarted it 
causes the field to keep the value last entered in it. If set 
to false, when the window is restarted it clears the field. 

ScrollBars* If set to true, a text field has scroll bars. If set to false, no 
scroll bars are displayed. 

SetChangeFlag* Specifies whether changes to a field's value set the change 
flag for the form or window. If set to true, the change flag 
is set when the contents of the field change. If set to false, 
the change flag is not set. 

SortMethod 
 

Specifies how items in list view or tree view fields are 
sorted. 

TabStop* Specifies whether the field should be included in the 
window's tab sequence. If set to false this field is not 
included. 
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Object Properties Description 
Tooltip* Can be used to specify additional information about a 

field on a window. The additional detail displays as a user 
drags their mouse over the given field. This property is 
available for all fields. The maximum size of a tooltip is 
79. 

UseUniqueHelp If set to true, a unique HelpContextID is generated for this 
instance of the field. If set to false, the same 
HelpContextID is generated for all instances of this field 
within the application. 

VisibleItems* 
 

For drop-down list and combo box fields, specifies the 
maximum number of items displayed when the list is 
displayed in the dropped position. 

WordWrap* If set to true, text automatically word wraps when typed 
to the right edge of the field. This also removes the 
horizontal scroll bar from the field. This property is only 
available for text fields. 

Alignment* Specifies whether contents should be Center, Left, or 
Right aligned. 

AltLineColor* 
 

If set to true, alternate lines of the list view will appear 
with a different color. 

Appearance* Changes the way the object is displayed on the window. 
Select from: 2D Border, 3D Border, and 3D Highlight. 

BackColor* Specifies the background color of the field. 
Border* If set to true, a border is drawn around the field. 
Direction* 
 

For progress indicator fields, indicates the direction the 
bar will move in the progress indicator. 

DropIndicator* 
 

For button drop list fields, specifies whether the drop 
indicator will be displayed. 

DropPosX* 
 

For button drop list fields, specifies the distance in pixels 
the drop indicator will be drawn from the right edge of the 
control. 

DropPosY* 
 

For button drop list fields, specifies the distance in pixels 
the drop indicator will be drawn from the bottom edge of 
the control. 

ExpandButtons* 
 

For tree view fields, setting this property to true causes 
expansion buttons to be shown for nodes that have 
children. 

Font* Specifies the font to use for the field. 
Font-Bold* If set to true, the field text is displayed in bold type. 
FontColor* Specifies the color of the text for the field. 
Font-Italic* If set to true, the field text is displayed in italic type. 
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Visual Properties Description 
Font-Underline* If set to true, the field text is underlined. 
FullRowSelect* 
 

When set to true, the entire row in the list view field is 
selected. When set to false, individual row items can be 
selected. Applies only when the list view is displayed in 
report view mode. 

GridLines* 
 

When set to true, grid lines are drawn between items in 
the list view. Applies only when the list view is displayed 
in report view mode. 

ImageSize* 
 

Specifies how list view images are sized. System 
indicates the images will be scaled to standard system 
sizes (16 by 16 or 32 by 32 pixels). First Image indicates 
images will be scaled to the size of the first image defined 
for the list view field. 

Indent* 
 

For tree view fields, specifies how many pixels child 
nodes are indented from the parent. The value 0 allows 
the control to automatically specify the amount. 

IndicateColor* 
 

Specifies the color of the progress indicator blocks or bar. 

Lines* 
 

Specifies how lines are drawn in the tree view field. If set 
to None, no lines are drawn. If set to TreeLines, lines are 
drawn for nodes below the root level. If set to RootLines, 
lines are drawn for all nodes. 

Pattern* Specifies the pattern to apply to the background. 
PatternColor* Specifies the color of the pattern that is applied to the 

background. 
PatternSelect* 
 

Specifies the pattern used when a push button-style check 
box is selected. 

Position − Left* Indicates the position of the left edge of the field, 
measured in pixels from the left edge of the window. 

Position − Top* Indicates the position of the top edge of the field, 
measured in pixels from the top of the window. 

Resize − 
Horizontal* 

Indicates how a field should grow or shrink horizontally 
when resized. 

Resize − Vertical* Indicates how a field should grow or shrink vertically 
when resized. 

Scaling* 
 

For picture fields, specifies how the picture pasted into 
the field will be scaled. Proportional indicates the picture 
will maintain its original size and proportions. Stretch 
indicates the picture will be stretched to fill the picture 
field.  
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Visual Properties Description 
ShowHeadings* 
 

When set to true, column headings are shown in the list 
view. Applies only when the list view is displayed in 
report view mode. 

ShowPartialItems* 
 

For native list boxes, setting this property to true causes 
the list box to be drawn exactly the height indicated in the 
layout window. If there is not enough room to display the 
last item, it will be only partially drawn. When this 
property is set to false, the list box will be resized 
vertically to include just the last complete item.  

ShowSelection* 
 

For tree view and list view fields, indicates whether the 
selected node or item is indicated when the field does not 
have focus. 

Size-Height* Indicates the field height, measured in pixels. 
Size-Width* Indicates the field width, measured in pixels. 
Style* 
 

For push button and button drop list fields, specifies 
whether the button will display text only, graphics only, 
or both text and graphics. It also specifies the arrangement 
of the text and graphics. 

Visible* If set to true, the field is visible to the user. If set to false, 
the field is hidden. 

Zoom* For push button fields, setting this property to true causes 
the pointer to become the zoom pointer (magnifying 
glass) when it is moved over the field. Typically, the 
Visible property is also set to false to make the push 
button invisible. 
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Working with Field Properties 
There are some general things to know when working with field properties. They 
include: 
 

• The Required selection cannot be set to false for fields already 
selected as required in the original forms. However, the fields set as 
required can be unmarked at a later time. 

• Fields cannot be made invisible if they are required by Microsoft 
Dynamics GP. If this is the case, the settings box does not allow you 
to scroll down when the Visible property is selected. 

• If a field is made invisible, it should also be made non-editable to 
avoid accidentally moving the cursor to the field with the Tab key or 
the mouse. 

• Making a field invisible makes the field not appear in a Microsoft 
Dynamics GP window, including viewing it with Modifier. 
However, if the Show Invisible Fields option is selected from the 
Layout menu within the Modifier, the field is displayed again so you 
can select it as visible. 

• The fonts displayed are those currently supported with Modifier. 
Additional fonts installed in your operating system do not appear in 
this list. 

 

Repositioning the Field on the Window  
Using the arrow tool, drag the field to the location in the window where you want 
it to appear. If the field has a prompt, select the prompt and the field at the same 
time to move both objects on the window layout. 

Previewing and Saving the Modifications 
Select Preview from the Layout menu to preview the changes made to the 
window. The form is not functional, but it displays your modifications. 
 
Continue making changes to this window using other procedures in this manual, 
or save the changes to this window by closing the layout. When closing the 
layout, an alert message appears asking you to Save, Discard, or Cancel the 
changes. If satisfied with the changes to this window, click the Save button.  
 
To view all of the changes made with Modifier, return to Microsoft Dynamics 
GP and grant access to the modified windows using either the User Class Setup 
or Security Setup window. 
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Adding Fields to a Window 
By adding fields to an existing Microsoft Dynamics GP window, you can create 
data entry forms that are customized to meet your business needs. Use Modifier 
to add fields to a window two different ways.  
 

• Add fields to a window from a Microsoft Dynamics GP table that is 
auto-linked to the window. 

• Create new fields to add to the window that are populated through 
the use of Visual Basic for Applications.  

 
Many of Microsoft Dynamics GP windows are automatically linked to a 
particular table to make the transfer of information between the window and table 
possible. Because of this, if a field in the auto-link table does not currently appear 
on the corresponding Microsoft Dynamics GP window, it can be added to the 
window using Modifier. Then since the field is contained in the auto-linked table, 
Microsoft Dynamics GP code already exists to handle the transfer of information 
for that field. In addition, if two or more windows share the same auto-linked 
table, fields in the table can be moved from one window to another. This can 
occur without affecting the integrity of the data or the accounting logic in the 
application.  
 
New fields can also be created through Modifier. These new fields can be added 
to any of the existing Microsoft Dynamics GP windows. Visual Basic for 
Applications code can then be written to display information in those new fields 
or to store the information in a new data table. 

Adding Linked Fields  
Open the window layout for the window you want to modify. If a table is auto-
linked to that window, the table appears in the drop-down list within the 
Toolbox. Select the linked table and scroll through the list to view all fields that 
exist in that table. If there are fields to add to the window, use the arrow tool to 
highlight the field and drag it to the window layout.  
 

 
 
NOTE: Not all Microsoft Dynamics GP windows have an AutoLink table. 
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In Microsoft Dynamics GP, navigate to the Vendor Maintenance window by 
selecting CARDS→PURCHASING→VENDOR. From the menu, select 
TOOLS→CUSTOMIZE→MODIFY CURRENT WINDOW to open this window in Modifier. 
The PM_Vendor_MSTR table is auto-linked to the PM_Vendor_Maintenance 
window, but the window does not contain all of the fields in the table. For 
example, it does not include "Modified Date." This means you can add the 
Modified Date field to the layout using Modifier, and when entering the 
Microsoft Dynamics GP, the field is automatically shown. 
 
NOTE: To remove fields from the window's layout, highlight the field, and select Clear 
from the Edit menu. You can only remove the fields you added to the window; fields 
already appearing in the window must remain there, but can be made invisible using 
the Field Options window.  

 
NOTE: When a field is added to a window, the size of the field defaults to a size 
determined by its keyable length, format, font, point size, and style. If you resize the 
field so it is shorter than its keyable length, scroll the field horizontally to view all of 
the data for the field when it is displayed in the application. 

 

Creating New Local Fields 
Using Modifier new fields can be created and added to any of the existing 
windows in Microsoft Dynamics GP. These new fields are created as local fields 
and can be made in a couple of different ways. They can be created using the 
appropriate tool from the Toolbox window, or by clicking the New button on the 
Toolbox under the list of local fields.  

Using the Toolbox Window  
The Toolbox Window contains different types of objects available in the 
application. To add an object to an existing window, select the appropriate tool 
you want to create. Move the cursor to the window layout area, and click where 
you want to position the new object. The new object is drawn on the window and 
defaults with a name corresponding to the type of tool used to create it. For 
example, a new check box field can be created with the name (L) CheckboxM29. 
The name can be changed to be more meaningful to the user. 
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New local fields that have been created can be displayed by selecting Local 
Fields from the drop-down list. New local fields can also be created using the 
New button, or local fields that already exist can be edited using the Open 
button. 
 

 
 
The toolbox also contains tools you can use to add new fields to a window. As 
you move the cursor over each tool, the tool tip will display. A description of the 
tool can be found in the help file (Toolbox, creating local fields).   
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NOTE: If multiple option buttons are added to a window, they must be in a radio group 
or they will not be visible at runtime. First draw the radio group onto the window, and 
then place the option buttons inside. 

 
After the new fields have been created, they can be further defined using the 
Local Field Definition window.  

Using the Local Field Definition Window 
The Local Field Definition window can be used to create new fields to add to a 
Microsoft Dynamics GP window. It can also be used to edit a new field created 
using the Toolbox. To open the Local Field Definition window, select Local 
Fields from the drop down list found on the Toolbox. To create a new field, 
select the New button that appears under the list of local fields. If a new field 
already exists that you want to edit, highlight that field from the list, and click the 
Open button. The Local Field Definition window appears as shown below.  
 

 
 
Using the Local Field Definition window, select to change the name assigned to 
the field, specify a Lookup Form, indicate an Array Size, change the Control 
Type, or assign Static Text Values. To save any changes made, click the OK 
button. The Local Field Definition window closes, and you can select to add the 
field to the window by clicking on it within the list of local fields and dragging it 
to the window layout area.  
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Field Name 
The field name assigned to the local field is the name used to refer to the field 
using Visual Basic for Applications (VBA). If using the tools in the Toolbox to 
add a local field to the layout, a default name is created based on the control type 
and the order the field was placed in the layout. Using the Local Field Definition 
window, this default name can be changed to describe the field more clearly.  

Lookup Form 
The Lookup Form field allows you to attach a lookup form to the field. When a 
lookup form is attached to the field and the focus is on the field, the user can 
open the attached form by clicking Lookup from the Help menu. Click the 
lookup button to open the Resource Lookup window, where you select a form to 
function as the lookup form. 
 
NOTE: The Lookup Form feature is no longer used in Microsoft Dynamics GP. Rather, 
the Lookup buttons are linked to the fields using the Link Lookup option on the Tools 
menu. 

 

Array Size 
An array field contains multiple occurrences of the same type of information. 
The individual pieces of information stored here are referred to as elements. 
When creating a field, you enter an array size for the field. The array size of a 
field indicates the number of elements included in the array field. If the field is 
not an array, set it to 0. For example, you could create an array field called Phone 
to store two phone numbers by specifying an array size of two. Note that Phone 
is a single field, but that it has two elements, each containing a phone number. 

Control Type 
This defines the control type of the local field. A control type is a specific data 
display and storage method. The following list are recommended control types 
that you can use for new fields:  
 

• Boolean  
• Button drop list  
• Check Box  
• Combo Box  
• Currency  
• Date  
• Drop-down list  
• Integer  
• List box  
• Long integer  
• Multi-select list box  
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• Non-native list box  
• Progress indicator  
• Push button  
• Option button  
• Radio group  
• String  
• Text  
• Time  
• Visual switch  

 
Some control types have the same storage type but are displayed in different 
ways. When a tool from the Toolbox is used to create the new field, the control 
type defaults according to the tool. Using the Local Field Definition window, the 
default control type can be changed.  

Static Text Values 
The Static Text Values lookup window allows you to define static text values for 
data types that use them. The following are control types that use static text 
values:  
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These static text values are strings that appear on the buttons or in the list fields. 
The following Static Text Values window displays when the lookup button is 
selected.  
 

 
 
To add static text values to a field, enter the string in the New Value field, and 
click the Insert button. To change an existing string, highlight the value within 
the Static Text Values list, make a change to the value using the New Value 
field, and click the Replace button. To remove a value, highlight the string and 
click Remove.  
 
The Sort List check box can be used to change the order of the values in a list 
field when it is displayed in runtime. When the Sort List check box is selected, 
the items in the Static Text Values list are sorted in alphabetical order when 
viewed in the application.  
 
NOTE: Selecting the Sort List check box does not sort the list in the Static Text Values 
window - the items are displayed in the order in which you inserted them. 
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The Button Items window is used to specify the static text for button drop lists 
and push buttons. The static text would be placed in the Caption area for the 
control. Buttom Items can contain images, captions or both. When a control type 
is selected that can contain an image and text, the format window will appear as 
follows: 
 

 
 

Making New Local Fields Functional 
After the new local fields are created, completely defined and added to a 
window, Visual Basic for Applications (VBA) code can be written to make them 
functional.  
 
NOTE: VBA is a component of the Microsoft Dynamics GP Modifier and is available 
after Modifier is registered.  

 

Adding Prompts for Each Field 
Select the text tool from the Toolbox to create a prompt for this field. Place the 
cursor where you want the prompt displayed, type the prompt name and then set 
any visual properties for the prompt by displaying the Properties window and 
making the appropriate selections on the Visuals tab. Refer to the "Modifying 
Field Displays" procedure for a detailed explanation of how to change properties 
for any prompts added to the layout. 
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There are several default property settings used for static field prompts. The 
following list of default properties should be used for static field prompts:  
 
Property Value 
Appearance 3D Highlight 
BackColor System-Button Face 
Border True 
Pattern (None) 
Pattern Color Black 

 

Linking Prompts for each Field 
It is important to link the field to the appropriate text prompt. With this you can 
see if the field is a required field or if it has been disabled. To accomplish this, 
select Link Prompt on the Tools menu. Hold your cursor over the field and drag 
it to the text prompt you want to link it to. After all fields have been linked, turn 
this option off using the Tools menu. 
 

 
 

Setting Properties for the Field 
You can set a variety of properties for the new fields added to the layout. These 
properties determine how the field is displayed and how data can be entered in 
the field.  
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Adding Fields to a Scrolling Window 
Types of Scrolling Windows 
Microsoft Dynamics GP scrolling windows are designed to display multiple lines 
of information with each line representing one record in a corresponding table. 
This is unlike other Microsoft Dynamics GP windows that display only one 
record at a time. There are three types of scrolling windows, they include the 
following: 
 
Type Description 
Browse Only Allows viewing of records. 
Editable Allows editing existing records but not adding new records. 
Adds 
Allowed 

Allows the same abilities as the Editable scrolling window, 
but also allows adding of new records. 

 
In Modifier, to access the layout of a scrolling window, first open the window 
layout for the window that contains the scrolling window. Then double-click the 
scrolling window to open its layout window.  

Line Item Sections 
The layout can be divided into two areas, the Small Line Item section and the Big 
Line Item section. The Small Line Item area displays when the scrolling window 
is shown. The Big Line Item area can be displayed or hidden depending on 
whether the user has selected the Show Button or the Hide Button.  
 
A Small Line Item section is required. The Big Line Item section is optional.  
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Viewing Line Item Markers 
The different sections of the scrolling window are identified by dotted lines that 
appear within the layout. However, the dotted lines are not evident unless the 
objects on the window are moved. Fields included above the first dotted line in 
the scrolling window are part of the Small Line Item. The fields included 
between the two dotted lines are part of the Big Line Item. 
 

 
 
NOTE: In Modifier, the Small Line Item and Big Line Item sections can also often be 
identified by the different colors assigned to the fields in each section. Typically, the 
Backcolor for the fields in the Small Line Item are white and for the fields in the Big 
Line Item yellow.  

 

Changing Line Item Markers 
To change the size of the Small or Big Line Item sections, use the Mark Small 
Line Item and Mark Big Line Item options on the Tools menu. These options 
allow you to move the dotted line markers. After selecting the option, the cursor 
changes to indicate that you are ready to select a new section size. Click where 
you want the new marker to be. Make the section either smaller or larger 
depending on where the new mark is made.  
 
HINT: Before changing the Line Item Markers, you may want to see the names of the 
fields inside of the scrolling window. To view the field names, click Show Field Names 
on the Layout menu. 

 

Scrolling Window Fields 
After opening the scrolling window layout, fields can be added to the window the 
same way they were added to other windows. Add a field from a linked table by 
using the Fields list in the Toolbox, or create a new local field using the Toolbox 
or the Local Field Definition window. You can also rearrange fields, or change 
the properties of fields as on other windows.  



Microsoft Official Training Materials for Microsoft Dynamics ™ 
Your use of this content is subject to your current services agreement 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Modifier with VBA in Microsoft Dynamics GP 9.0 

Page 68 

Setting the Tab Sequence 
A tab sequence is the order the fields are highlighted in a window when the tab 
key is pressed. Although the tab sequence has already been set for all Microsoft 
Dynamics GP windows, changes made to a window's layout or new fields added 
to a window can render an existing tab sequence ineffective. You can change the 
existing tab sequence to match the order your data entry personnel uses to enter 
information, ensuring they enter the most important information first. When 
entering transactions and other data this accomplishes the following:  
 

• Reduces unnecessary keystrokes 
• Enables users to enter data in a logical order  
• Increases keyboard efficiency and speed  

 

Activate the Tab Sequence Mode 
Select the form to modify and open the Layout window. From the Layout menu, 
click Set Tab Sequence. The menu selection appears as activated, and is 
indicated with a check mark next to the menu selection. To deactivate the tab 
sequence mode, remove the check mark by selecting it again from the Layout 
menu. The first field in the current sequence appears shaded in the window's 
layout.  

Select the First Field in the Sequence 
If the first field you want in the tab sequence is not currently shaded, select it by 
double-clicking the field. This is the field where the cursor appears when first 
opening the window. The field you double-click appears shaded, meaning it is 
now set as the first field in the tab sequence.  
 

 
 

Press the TAB Key 
Press the TAB key to see the next field in the new sequence. If you double-clicked 
on a field in the previous step, the highlight returns to the first field in the old 
sequence. When a change is made to a window's tab sequence, the new field you 
select is inserted before the first field in the old sequence. The old field continues 
to be the next field in the tab sequence until the entire sequence is set. 
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Select the Second Field in the Sequence 
Locate the next field in the sequence. Insert the field by double-clicking it. The 
field appears shaded. 

Press the TAB Key 
When you press the TAB key, the highlight returns to the first field in the old tab 
sequence.  

Select Remaining Fields in the Sequence 
Continue to select fields in the window in the order you want, using the mouse to 
double-click the field and the TAB key to move the highlight to the next object in 
the sequence.  
 
When finished, test the tab sequence by pressing the tab key several times. The 
highlight moves from field to field in the sequence set. If the sequence is not set 
properly, repeat the steps for setting the tab sequence until it is set to the desired 
order.  
 
Things to consider when working with the tab sequence: 
 

• If you do not want a certain field to be included in the tab sequence, 
set the TabStop property for that field to false. The TabStop property 
is set using the Objects tab on the Properties window. 

• Be sure that each radio button follows the radio group when setting 
the tab sequence. To make radio buttons work properly in your 
application, the radio group and radio button fields must be arranged 
properly in the window. In the tab sequence, the radio group must 
come immediately before the radio buttons. 

• You can encounter a "stacked" fields issue on some Microsoft 
Dynamics GP windows. For example, any transaction window that 
supports multi-currency typically has both a Sales Amount and 
Originating Sales Amount field. These are placed on top of each 
other on the form. Make sure you set both fields back to back in the 
tab sequence. 

• Be aware that the tab sequence in some Microsoft Dynamics GP 
windows can be overwritten by the business logic. The code can 
place focus to a specific place. 

• You can set the tab sequence in an adds allowed and editable 
scrolling window. This is an important step that must happen for the 
LineChange event to fire properly.  
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Preview and Save the Modifications 
Preview the changes made to the window by selecting LAYOUT→PREVIEW. The 
form is not functional but displays with your modifications. 
 
Continue making changes to this window using other procedures in this manual, 
or save the changes to this window by closing the layout. When closing the 
layout an alert message appears asking you to Save, Discard, or Cancel the 
changes. If satisfied with the changes to this window, click the Save button.  
 
To view all of the changes made with Modifier, return to Microsoft Dynamics 
GP, and grant access to the modified windows using either the User Class Setup 
or Security Setup window. 

Adding Graphics to a Window 
Graphics used in your business, such as a company logo, pictures, and the 
symbols you use in day-to-day activities, can be added to the Microsoft 
Dynamics GP application with standard copy-and-paste techniques. Each of these 
graphics are stored in Modifier using the picture library. Once a graphic's been 
added to the library, it is available for use on any of the Microsoft Dynamics GP 
windows.  
 
Modifier's picture library allows you to add, name, and store specific graphics in 
Modifier. When storing the graphic, Modifier stores it in a generic format. For 
example, if modifying windows in a multi-platform environment, you can create 
an icon using a graphics program, store it in the Modifier's pictures library, and 
paste it onto several different windows. The graphic appears in Windows the 
same way as it was created on the other platform. 
 
The following procedure explains the process of adding a graphic to Modifier's 
picture library and to a window layout. 

Using the Picture Tool 
Open the layout area for the window you want to add a graphic to. Select the 
Picture tool from the Toolbox. Click at the position in the window layout where 
you want to add the object. A list of existing graphics displays, click the New 
button to create a new picture. To add an existing graphic to the window, 
highlight a picture from the list of existing graphics and click OK. 
 
NOTE: Selecting Pictures can also add graphics to the picture library from the 
Resources menu in Modifier. 
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Enter a Name for the Graphic 
If New is selected to create a new picture, when the Picture Definition window 
opens, specify the name for the graphic. Then click in the picture layout area 
beneath the Picture Name field.  
 

 
 

Copy and Paste the Graphic 
After the layout area has been activated, move to the graphics application that 
contains the picture you want to add to the window. For example, switch to 
Microsoft Paint. Select or create a graphic within that application, and then select 
the Copy command from the Edit menu to place it on the Clipboard. Select only 
the portion of the graphic you want to paste in the window. When finished, 
switch back to Modifier. 
 
With the Picture Definition window active, click Paste from the Edit menu to 
paste the graphic to the picture layout area. 
 

 
 
When the graphic appears, click OK. The Pictures window displays with the 
name of the graphic in the list. Click OK to save the changes and close the 
Pictures window. 
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Select the Graphic 
Select the graphic from the Pictures list and click OK. The picture appears in the 
window's layout. Then move or resize the object as needed. 

Preview and Save the Modifications 
Preview the changes made to the window by selecting LAYOUT→PREVIEW. The 
form is not functional but displays with the modifications.  
 
Continue making changes to this window using other procedures in this manual, 
or save the changes by closing the layout. When closing the layout, an alert 
message appears asking you to Save, Discard, or Cancel your changes. If 
satisfied with the changes to this window, click the Save button.  
 
To view all of the changes made with Modifier, return to Microsoft Dynamics 
GP, and grant access to the modified windows using either the User Class Setup 
or Security Setup window. By rearranging fields in a window, you can change 
the sequence of information data entry personnel enter, ensuring they enter the 
most important information first. This reduces unnecessary keystrokes and 
enables users to enter data in a logical order. After rearranging fields in a 
window, refer to the "Setting a Tab Sequence" procedure to be sure a window's 
tab sequence reflects the latest changes made to the window. 
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Conclusion 
In this chapter you learned that Modifier can be used to customize windows by 
changing or adding objects to the window. The layout of the window can be 
customized to add additional fields from the auto-linked table and new local 
fields can be created and placed on the window. You learned how to customize a 
scrolling window and add text for fields added to both windows and scrolling 
windows. Setting a new tab sequence for a window was also discussed. 
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Lab 3.1 − Modifying Individual Window Prompts  
Company: Fabrikam, Inc. 

 
Scenario: This exercise goes through the process of changing several prompts in 
the Company Setup Window's layout, as well as repositioning prompts and 
changing their color, font, and style. 

Challenge Yourself!  
 

• Navigate to the Company Setup window, and use the following 
information to customize the window: 

 

 
 

• Change the text prompts to display Category 1 and Category 2. 
• Change the modified text prompts so they appear bold and pink. 
• Validate your changes by viewing the window within Modifier. 
• Allow the appropriate users to access this customized window. 
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Need a Little Help? 
 

• Navigate to the Company Setup window, and use the following 
information to customize the window. Open this window from the 
Microsoft Dynamics GP application from the Company option on the 
Tools menu. You can also use Modifier to open the form definition 
window using the Technical name, which is SY_Company_Options. 

• Using the static text tool, change the User Defined text prompts to 
display Category 1 and Category 2. 

 

 
 

• Using the properties window, change the modified text prompts so 
they appear bold and pink. 

• Validate your changes by viewing the window within Modifier. 
• Save the changes you made. 
• Return to the Microsoft Dynamics GP application, and grant security 

to the Modified window using the Security Setup window. 
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Lab 3.2 − Modifying Field Displays 
Company: Fabrikam, Inc. 

 
Scenario: This lesson goes through the process of modifying a window by 
changing how fields display information in the window. You have determined 
that the information displayed in the Company Addresses window is important 
for your data entry personnel to view, but you do not want to allow them to 
change certain information displayed for your company's multiple locations.  

Challenge Yourself!  
 

• Navigate to the Company Address Setup window, and use the 
following information to customize the window: 

 

 
 

• Because you do not want certain users to have the ability to change 
or delete information in this window, change all fields to be non-
editable fields except the Address ID field, the Name field, and the 
Clear button. These non-editable fields should also be excluded 
from the tab sequence. 

• Validate your changes by viewing the window within the Modifier. 
• Allow the appropriate users to access this customized window. 
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Need a Little Help? 
 

• Navigate to the Company Addresses Setup window. To access this 
window, navigate to the Company Setup window and use the 
Address button to open the Company Addresses Setup window. You 
can also open this form and window within Modifier using the 
Technical name, which is SY_Company_Location. 

• Because you do not want certain users to have the ability to change 
or delete information in this window, select the appropriate fields 
and assign the properties as indicated: 

 
Editable False 
TabStop False 

 
• Validate your changes by viewing the window within Modifier. 
• Return to the Microsoft Dynamics GP, and grant security to the 

modified window using the Security Setup window. (Security might 
already be set if a previous project was done by changing the 
opening position of this window.) 
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Lab 3.3 − Adding Fields to a Window 
Company: Fabrikam, Inc. 

 
Scenario: This lesson goes through the process of modifying a window by 
adding a field from the table that is linked to the window and by adding a new 
field that you can use later with Visual Basic for Applications. For this lesson, 
you add a new string field and a field from the RM_Customer_MSTR table to the 
Customer Maintenance window. You also create prompts for these new fields. 

Challenge Yourself!  
 

• Use the following information to customize the Customer 
Maintenance window: 
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• Add the Tax Registration Number field to the window from the 
auto-linked table. 

• Move the status area down to make room for the Email Address 
field. Add a local string field called Email Address to the window 
layout. The keyable length for the string should be 20. 

• Add text prompts for the two fields that were added to the layout. Set 
the appropriate properties so they display the underline.  

• Link the two new fields to their text prompts. 
• Change the tab sequence of the window so that the cursor stops at the 

new fields on the window. Since the Tax Registration Number is a 
non-editable field, it does not need to be included in the tab 
sequence.  

• Validate the changes by viewing the window within the Modifier. 
• Allow the appropriate users to access this customized window.  

 
 
 
 
 

Need a Little Help?  
 

• Navigate to the Customer Maintenance window. You can also open 
this form and window within Modifier using the Technical name 
which is RM_Customer_Maintenance. 

• Add the Tax Registration Number to the window layout from the 
auto-linked table.  

• Move the status area down to make room for the Email Address 
field. Add a local string field called Email Address to the window 
layout. The keyable length for the string should be 20. 

 

 
 

NOTE: Data is not displayed in the Email Address field until code is written using 
Visual Basic for Applications (VBA) to handle this information.  
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• Add text prompts for the field that was added to the layout. Set the 
appropriate properties so they display the underline.  

 
Appearance 3D Highlight 
Border True 

 
• Select Link Prompt from the Tools menu, and link the two new fields 

to their text prompts. 
• Change the tab sequence of the window so that the cursor stops at the 

new fields on the window. Since the Tax Registration Number is a 
non-editable field, it does not need to be included in the tab 
sequence.  

• Validate the changes by viewing the window within Modifier. 
• Return to Microsoft Dynamics GP, and grant security to the 

Modified window using the Security Setup window. (Security might 
already be set if a previous project was done by changing the 
opening position of this window.) 

 
NOTE: Data is not displayed in the Email Address field until code is written using 
Visual Basic for Applications (VBA) to handle this information.  
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Lab 3.4 − Adding Fields to a Scrolling Window 
Company: Fabrikam, Inc. 

 
Scenario: This lesson goes through the process of modifying a window by 
adding a field from the table that is linked to the scrolling window. For this 
lesson, you add a Comment field from the IVC_HDR_WORK table to the 
Invoicing Document Inquiry window. You add the field to the Big Line Item 
section of the scrolling window. You also create a text prompt for this field. 

Challenge Yourself!  
 

• Navigate to the Invoicing Document Inquiry window, and use the 
following information to customize the window: 

 

 
 

• Open the layout for the scrolling window. 
• Make the big line item section area larger so the Comment field can 

be added. 
• Add the Comment field to the big line item area of the scrolling 

window. Place it below the other fields on the window. 
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• Select the appropriate properties for the Comment field so the color 
matches the other fields in the big line item area. Also turn the 
border of the comment field off. 

• Using the Line Tool, draw a horizontal line under the Comment 
field. 

• Add a text prompt above the scrolling window identifying the 
Comment field that has been added.  

• Validate your changes by viewing the window within Modifier. 
• Allow the appropriate users to access this customized window.  

 

Need a Little Help?  
 

• Navigate to the Invoicing Document Inquiry window. You can also 
open this form and window within Modifier using the Technical 
name which is IVC_Transaction_Inquiry. 

• Open the layout for the scrolling window. 
• Using the Big Line Item selection under the Tools menu, make the 

big line item section area larger so the Comment field can be added.  
• Add the Comment field to the big line item area of the scrolling 

window. Place it below the other fields on the window. 
• Select the appropriate properties for the Comment field so the color 

matches the other fields in the big line item area. 
 

BackColor Yellow 
Border False 
Pattern 75% Shading 
Size-Width 580 

 
• Using the Line Tool, draw a horizontal line under the Comment 

field. The big line item area should look as follows: 
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• Add a text prompt above the scrolling window identifying the 
Comment field that has been added.  

 

 
 

• Validate the changes by viewing the window within Modifier. 
• Return to Microsoft Dynamics GP, and grant security to the 

Modified window using the Security Setup window.  
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Quick Interaction: Lessons Learned 
Take a moment and write down three Key Points you have learned from this 
chapter: 
 
1. 

 

 

 

 

 
 
2. 

 

 

 

 

 
 
3. 

 

 

 

 

 
 


